e
©® BROADCOM

AFBR-S50
Evaluation Kit Quick Start Guide

User Guide
Version 1.3

Broadcom AFBR-S50-EK-UG103
March 30, 2023



AFBR-S50 User Guide Evaluation Kit Quick Start Guide

Copyright © 2019—-2023 Broadcom. All Rights Reserved. The term “Broadcom” refers to Broadcom Inc. and/or its
subsidiaries. For more information, go to www.broadcom.com. All trademarks, trade names, service marks, and logos
referenced herein belong to their respective companies.

Broadcom reserves the right to make changes without further notice to any products or data herein to improve reliability,
function, or design. Information furnished by Broadcom is believed to be accurate and reliable. However, Broadcom does
not assume any liability arising out of the application or use of this information, nor the application or use of any product or
circuit described herein, neither does it convey any license under its patent rights nor the rights of others.

Broadcom AFBR-S50-EK-UG103
2


http://www.broadcom.com

AFBR-S50 User Guide Evaluation Kit Quick Start Guide

Table of Contents

Chapter 1: Getting Started ... ——————————— 4
1.1 Evaluation Kit OVEIVIEW ............oooiiiiiiiiiii ittt e e e ettt e e e e e e bt e e e e s btae e e e e nbeeeeeeasteeaeeennreeeeeennnres 4
1.2 Hardware and SOftWare SEHUP .............ooiiiiiiiii e ettt e e et e e e e e e e e e nnneeas 4
1.3 Updating the Device SOFtWAKIE .............cooi i et e e e e e 6
1.4 Performing a Distance MeasUIreMEeNt ................occuuiiiiiiiiiiii i et e e e e e e e e e et e e e e e nreee e e eneeeas 8

Chapter 2: AFBR-S50 EXPIOIer .....oceueeiiiiiiiiiiiirirrsssssssssssssssssssss s s s s s s s s s s ssssmssssssssssssssssssssssssssnnnnns 10
2.1 AFBR-S50 EXPIOIrer OVEIVIOW .........ooiiiiiiiiii i ittt e e e e e e e ettt et e eae e e e s e aa b sbaeeeeaaaaaeeesaaasassasaeeeaaaeeeesesansenrenes 10
2.2 EXPIOring the MENU Bar...........oooi ittt e sttt e e e e b et e e e s bbb e e e e e aante e e e s anbeeeeeeannneeeas 11
2.3 Data Visualization VI@WS ...ttt e e e e e e et ettt et e e aaae e e e s e neebeeeeeeaaaaeeeeaaannneneeees 14

P2 TR B 1 I [ Y = SR 14

D B 1 B o o) Y41 PP 19

P TR B o= (T I = e T AT 21

2.4 TOOI PANEI OVEIVIEW ...ttt e bt et e b e e b et e e eh bt e e et e e et e e e s bt e e s e e e narne e eaneas 23
D I N B I | o PSPPI 23
o I T 3= q T TN O 7= RSP 25

2.4.1.2 Range Offset CalibDration ...........cooiiiiiiiiiiiieee e e e e e e e e e e e e e e s e s rereeaaaaeeeeaaans 26

2.4.1.3 Crosstalk Calibration..........c..uueiiiiiiiiee et e e e e e e e e e e et e e e e ae e e e e e e e a e trrnraaaeeeaaaaanns 27

A S TU 40T o 0= A I o R SRR 28
P B @ o7 (o] F- T I o SR OUPPPRP 29

2.5 MUIi-DEVICE USAQE ......ooiiiiiiiiiiei ittt e ettt e oottt e e e e a bttt e e e s sttt e e e e aabe e e e e e aabbee e e e e anab e e e e s annbeeeaesannneeeas 30

Appendix A: Troubleshooting and FAQS .......ccuiiiiiiiiiiiiirrr s e e e s s 31
A.1 Related DOCUMENLS ... e s ms e e e e e e e s s e s ae s mmmeeeeeeeessasa e smmmmmeeneesesssasasssannmnnneeenesessannnen 31
A.2 Different Versions of Explorer and Controller Board ............cccccciiiimmiiiiiiinsssccccssscsseeeese s s s s ssssssssesesssssssnsses 31
A.3 SCI Error — No Communication t0 SENSOr ........ccccciicimiimiiiiiiiicsccssssrnrr e s s s s s sssmssr s e e e s s e s s ss s s sasnmssnesenssnnssnnssn 32
A.4 Xtalk Calibration — 3D Plot Is NOt Visible ... e e 32
A.5 Xtalk Calibration — AmMPlItUde EITOr ... ssrsr e s e s s s s smm s e s e e e s s e e s e amnmn e e e e e e e e eesennnnn 32

ReVISION HISTOIY ....ccooiiiiiiiiiii i anns 34
AFBR-S50-EK-UG103; March 30, 2023 ............ccoooiieerireieeaeeressssmreesssssne e s ssssms e s sesssane e s sassamsessessamnessssssnnsessessnnsesssnsannes 34
AFBR-S50-EK-UG102; November 30, 2020 ..........c.cccouirimmirinrininrrassmsssssssssssssssssssssssssssssssssssssssssssssssssssssssssassssssssnssssnns 34
AFBR-S50-EK-UG101; May 6, 2020.........cccceeeeeerrrrsessmreerssssnrersssssssesssssassesssssssssessssssssesssssssnsessassansessssssnnsessassansesssssannes 34
AFBR-S50-EK-UG100; December 6, 20719 .........cooocoieiiierer e e esesme e s esssme e s s s smme e s sssssme e s s s mn e e e s e smme e e s s snmneeessssnnees 34

Broadcom AFBR-S50-EK-UG103

3



AFBR-S50 User Guide Evaluation Kit Quick Start Guide

Chapter 1: Getting Started

1.1 Evaluation Kit Overview

The Broadcom® AFBR-S50 evaluation kit is composed of the following main components:

m  NXP FRDM-KL46Z evaluation board: Embedded microcontroller platform (ARM Cortex-M0+) used to read out the
AFBR-S50 ToF sensor's data and exchange with the PC.

m  AFBR-S50 adapter board: The circuit board on which the AFBR-S50 ToF sensor is mounted. It delivers out-of-box
connection between the sensor and a microcontroller board without the need for soldering (just plug and play).

= USB-mini cable: Required to establish a communication between the AFBR-S50 and your system environment (for
example, PC, embedded application system).

Download the software development kit (SDK) from the Broadcom website:
https://www.broadcom.com/products/optical-sensors/time-of-flight-3d-sensors/

Figure 1: Evaluation Kit Components

AFBR-S50 < S
Explorer Application .%»

1.2 Hardware and Software Setup

Step 1: Install the main application and all necessary drivers by using the AFBR-S50 SDK setup wizard. The initial setup
wizard window displays as follows.

Figure 2: Initial Setup Wizard Window

5 AFBR-S50 SDK Setup = X

Welcome to the AFBR-S50 SDK Setup
Wizard

The Setup Wizard will install AFBR-S50 SDK on your
computer. Click Next to continue or Cancel to exit the
Setup Wizard.

£ BROADCOM

Back Next Cancel

Broadcom AFBR-S50-EK-UG103
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Step 2: Install the main driver and all additional modules to enable the full performance of the device:

Figure 3: Installing the Device

(15 AFBR-S50 SDK Setup — X

Custom Setup © BROADCOM" Windows Security

Select the way you want features to be installed.

Would you like to install this device software?

Click the icons in the tree below to change the way features will be installed.

Name: AFBR-S50 Driver Package
The AFBR-S50 Explorer .

‘=] Documentation (vx-xx30000); an evaluation GUI for Publisher:

-2-| Device Software Binaries the AFBR-S50 Sensor modules.

[} ©+] AFBR-S50 AP
S| API Library Files
(- API Reference Manual This feature requires 2KB on your
hard drive. It has 2 of 2 subfeatures
selected. The subfeatures require OKB
on your hard drive.

Always trust software from

Location: C:\Program Files (x86)\Broadcom\AFBR-550 SDK\ —

which device software is safe to install?

@ You should only install driver software from publishers you trust. How can | decide
Reset Disk Usage Back Next Cancel

Install Don't Install

Step 3: Plug in the USB cabile.

CAUTION! The correct USB port for this step is labeled as KL46Z on the bottom side of the NXP board.

Figure 4: Connecting the USB Cable

gt &
L LI O |
N L]
W OHE
O &
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1.3 Updating the Device Software

When updating the AFBR-S50 SDK, the software on the evaluation kit must also be updated manually to match with the
installed GUI. This is done from the AFBR-S50 Explorer App by performing the following steps:

Step 1: Install the desired device software, as described in Hardware and Software Setup, and open the AFBR-S50 Explorer
App.

Step 2: Connect the red AFBR-S50 evaluation board via the OpenSDA interface to the PC. An additional driver is not
required.

Figure 5: Connecting the Red Evaluation Board with OpenSDA Labeled on the Bottom Side

Step 3: In the explorer App, go to menu Help > Flash Device Software > Flash..._USB.srec, and wait until the device is
successfully flashed.

Figure 6: Flash Device Software Option

Main Device #1  View | Help
Device #1: 0 - ﬁ "l| Flash Device Software ] Flash "AFBR.550.ExplorerApp.v1.4.4_KL46z_UART.srec” to "FRDM-KL48Z (E\)" ...
Flash "AFBR.S30.ExplorerApp.v144 KL46z USB.srec” to "FRDM-KL46Z (EN)" ...

1D Plot (#1) X | 3D Plot (2 Reset Application Layout
Measurement @ ©.08800 Reset Application Options s: -7 (Mot Initialized Error)
DCA: Integration Dept Reset All Samples
Optical Power: L H
Open Log File
—— RawRange Open App Data Fold
= Smoothed Rangg pen App Uata Folder
Sigma of Range Open Getting Started Guide
Open Release Motes
Open APl Reference Manual
Open AFBR-550 Product Page
About...
Broadcom AFBR-S50-EK-UG103
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Step 4: When flashed successfully, connect the device using the USB port labeled with KL46Z, and run it as described in
the following section.

Figure 7: Connecting the Device Using the USB Port Labeled KL46Z

5.5 ]

el e
F A LR S

Broadcom AFBR-S50-EK-UG103
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1.4 Performing a Distance Measurement

Step 1: Start the Explorer Application, AFBR.S50.Explorer.exe, for example, by clicking Windows Menu > AFBR-S50 SDK
> AFBR S50 Explorer.

Step 2: Open a USB connection by clicking the green plug symbol.

Figure 8: Green Plug Symbol

Device View Help

*¥ | Measure MiSingle M Start B Stop O Reset B

Device *

1D Plat X

Automatically detects and opens a USBE connection to the evaluation board

Measurement—roro== T o oo ar=

DCA: Integration Depth - Analog = ©.88@ Pattern; Digital = @ Samples
Optical Power: @ LSB; Pixel Gain: @ LSB

Step 3: Start the measurement by clicking Start.

Figure 9: Starting the Measurement

Device View Help

EDevice ¥ ¥ | Measure bllSingI* M Start *Stop O Reset _

1D Plot X | 3D Plot Raw Data | Starts a automatic and periodic range measurement.

Measurement Status: @ (OK) @ 2.000000 sec (Frame Rate: ©.88 Hz)
DCA: Integration Depth - Analog = 8.88@ Pattern; Digital = @ Samples

At =1 Prenns @ 160. A3anl Soln. 4 10D

ATTENTION: To troubleshoot problems with starting the measurement, see Troubleshooting and FAQs.

Step 4: Optionally, set up the device to your needs by choosing, for example, a measurement mode and frame rate both
before and while measuring. The changes will immediately become effective after pressing the respective Set buttons on
the right side of each applicable parameter.

Broadcom AFBR-S50-EK-UG103
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Figure 10: Measurement Mode after a USB Connection Has Been Opened

Frame Rate [Hz]

Enable PBA

~#) Configuration API

Measurement Mode

Data Output Mode

Dual Frequency Mode
Shot Noise Monitor Mode

Crosstalk Monitor

ShortRange

StreamingFull

X8

Dynamic

v | Get||Set
v | Get||Set
25| Get||Set
v | Get||Set
v | Get||Set

Get||Set

~#) Pixel Binning Algorithm (PBA)

Averaging Mode

Absolute Amplitude Threshold [LSB]
Relative Amplitude Threshold

Absolute Minimum Distance Threshold [m]
Minimum Distance Scope Enable

Absolute Minimum Distance Scope [m]
Relative Minimum Distance Scope

LAWA w
20

e.s

-0.010

[v]

0.e5e

t|[Set

@
']

NOTE: Information from the Configuration API section is loaded when a device is successfully connected to the explorer

app. The PBA default values differ among the sensor types.

Broadcom
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Chapter 2: AFBR-S50 Explorer

This section is intended to make the user familiar with the graphical user interface (GUI) of the AFBR-S50 Explorer
application and support the evaluation of a given ToF sensor device.

The AFBR-S50 Explorer software connects to the AFBR-S50 evaluation board using the USB interface. It receives the
measurement data from the device software running on the NXP board's microcontroller and displays it in a convenient way.
Furthermore, the ToF sensor device can be configured and calibrated by using the AFBR-S50 Explorer GUI.

2.1 AFBR-S50 Explorer Overview

Open the AFBR-S50 Explorer. The following screen is displayed.

Figure 11: AFBR-S50 Explorer Display Screen

Main Device #1 View Help
Device#t: 0 » ¥ *F o1 W m O _sCiTacest » M m _psalogh bouom

1D Plot (#1) X [3D Plot (#1) | Ra

s | vax
) Generie API
Device Info

~ APl
Measurement Mode shortRange
Data Output Mode streamingFull

Crosstalk Monitor 5

~ Pixel Binning Algorithm (PBA) —————————————————
Enable PBA v

P
A
A
Mi
A
Rel

lative ope o.04

~ Calibration AP ———————————
Range Offset [mm: o] G e

Pixel (00) Offset (mm] .0
Pixel 0,1) Offset [mm] .0
Pixel (02) Offset [mm] .0
Pixel (03) Offset [mm] e
Pixel (1,0) Offset (mm] .0
Pixel (1,1) Offset (mm] .0

Options.

Status/Log: 2023-63-13 20:55:63.711 # 1 Error: An excestion cccurred while serializing the layout to Filel Access to the path 'C:\Program Files (x86)\Broadcom\AFBR-S58 SOK\Resources\Layout.Temp.xml® is denied.  at System.I0._Srror.NinIOErro-(Int32 errorCode, String maybeFullPath)  at System.10.Filestr| Device #1: not connected

The AFBR-S50 Explorer main window consists of the following five basic elements:
1. Menu bar

2. Controller tool bar

3. Data visualization windows
4. Tool windows

5. Status bar

Broadcom AFBR-S50-EK-UG103
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2.2 Exploring the Menu Bar

The AFBR-S50 Explorer menu bar includes the following three elements:
m  Device

n View

= Help

Figure 12: Device Menu

View Help

il; Open USE Connection t

>1'|" Close Connection

Ml Trigger Single Measurement F2

P Start Measurements F3

B Stop Measurements F4
Data Logger r
Serial Trace [

I  Clear/Erase Flash
O  Reset MCU

From the Device menu, options are available to open and close the USB connection, trigger measurements, create a log

data file over a data logger to store measurement data, monitor and store the communication of the serial interface, and,
once connected, reset the microcontroller on demand.

All data measured by the ToF sensor device can be logged to a file for plotting and evaluating the measurement results. The
log file is saved to the entered path.

Figure 13: Data Logging Options

View Help

¥ Open USB Connection tart M Stop f) Reset

’1'|" Close Connection

Ml Trigger Single Measurement F2 -d Error) @ ©.000000 sec (Frame

MW Start Measurements F3 2@ Pattern; Digital = 8 Samples

@ LSE;

B Stop Measurements F4
Data Logger || B | Start Data Logging F9 ‘
Serial Trace #| Il | Pause Data Logging ‘

1  Clear/Erase Flash ® | Stop Data Logging

®  Reset MCU

The data logger starts recording once a destination path and file are chosen. In addition, another small menu bar for the data
logger is available.

After clicking Stop, a message appears in the explorer application with the information and the saved number of samples.

Broadcom AFBR-S50-EK-UG103
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Figure 14: Data Logger Recording Options

O Reset Data Logger: 1l Pause M Stop

Stops the currently ongoing data logging.

NOTE: The amount of data of the data logger output file can be changed by choosing a different data output mode from
the Configuration APl in the API section if Advanced Mode is enabled in tab options, section API Options (see also
Section 2.4.3, Options Tab).

For formatting reasons, open the created log file either with an advanced text application (for example, Notepad++) or import
it directly into a data analysis program. Another helpful debug feature is to perform a Serial Trace of all the bus transfers
between the microcontroller and the connected device. After the start of a Serial Trace, the application asks for a path to
save the Serial Trace Data. Both the Measurement Log Data and the Serial Trace are saved as .xt files.

Figure 15: View Menu

Device | View | Help

Serial Trace Tool Bar
Data Logger Tool Bar

Device Tool Bar

Options Panel
APl View
Summary View
1D Plot View
3D Plot View

EYES|EYENESIEY

Raw Data View

Single view modules can be enabled or disabled in the Explorer app with the View menu.

The Help menu is used to flash the current AFBR-S50 device software to the connected microcontroller, open the latest
status message log, reset the application values to default, and provide additional links to all necessary documentation on
the SDK.

Broadcom AFBR-S50-EK-UG103
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Figure 16: Help Menu

Device View

Flash Device Settings ...
Flash Device Software »

Reset Application Layout
Reset Application Options
Reset All

Open Log File
Open App Data Folder

Open Getting Started Guide
Open Release Notes

Open API Reference Manual
Open AFBR-S50 Product Page

About...

The AFBR-S50 Controller Tool Bar gives quick access to the most important operation elements regarding measurement
and Reset of the microcontroller. On the left it delivers a simple connect and disconnect menu to open up a connection via
USB port to the microcontroller on the evaluation kit board.

m Single: Sends a trigger signal to the device to perform a single measurement frame. Afterwards the device goes to idle
state.

= Start: Starts a periodic measurement loop.

m  Stop: Stops the periodic measurement loop and makes the device go to idle state. Note that this only stops the

measurement loop and prevents new measurements to be triggered. However, it does not stop a currently ongoing
measurement frame.

Figure 17: AFBR-S50 Controller Tool Bar

Device \View Help

E[}evice ¥ ¥ | Measure MiSingle M Start B Stop | O Reset

-

Broadcom AFBR-S50-EK-UG103
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2.3 Data Visualization Views

Below the AFBR-S50 Controller Tool Bar, all measurement data gathered by the ToF sensor device can be displayed in three
different views: 1D Plot, 3D Plot, and Raw Data. Each of the three views are introduced in the next sections.

Unlike the different views, the Measurement Status is always shown and gives information on the timestamp of the measured
signal, the corresponding frame rate, the Dynamic Configuration Adaption (DCA, the number of Digital averaging Samples),
optical power, and the pixel gain.

NOTE: The displayed Frame Rate may differ depending on the characteristics of your serial connection (for example, USB
cable length, and so on).

Figure 18: Measurement Status Example

Measurement Mode B: Short Range @ 457.715024 sec (Frame Rate: 25.8 Hz) - Status: @ (OK)
DCA: Integration Depth - Analog = @.406 Pattern; Digital = 115 Samples
Optical Power: High (55 mA); Pixel Gain: MediumHigh (29 LSB);

2.3.1 1D Plot View

The 1D Plot View consists of three plots and shows the measurement data in real time. It is the standard measurement view
displayed after the first start of a measurement. The x-axis for every chart inside the 1D plot View reflects the number of
measurement samples.

= Range Plot
= Amplitude Plot
m  Pixel Count Plot

Figure 19: 1D Plot View GUI

Device View Help

i Device ¥ *§ | Measure Misingle WStart M Stop O Reset _

1D Plot X [3D plot 3z
Measurement Status: @ (OK) @ 929.881688 sec (Frame Rate: 188.@ Hz) Mode B: Short Range

DCA: Integration Depth - Analog - 10.000 Pattern; Digital - 7 Samples
Optical Power: 55 mA; Pixel Gain: 34 LSB;

— RawRange —
— Smoothed Range
Sigma of Range

Rangs m]

100000 1000

Integration Energy
(Depth x Power)
— Amplitude

Amplitude LSB]
Pixs| Count

100

[#] AB8U3 wosiBeI|

10 1

1 01
0 20 40 60 20 100 0 20 40 60 20 100

Status/Log: 2019-10-21 16:29:23.634¢  Info: Data Logger: Aborted ...

Broadcom AFBR-S50-EK-UG103
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The Range plot element of the 1D Plot View is able to display up to four different range plots:

= Binned Range: Plots the average range over all pixels that are determined by the pixel binning algorithm. This value
represents the current range in meters.

m  Smoothed Binned Range: Plots a time based moving average of the Binned Range. To adjust the algorithm of the time-
based moving average, go to the 1D Plot Options View inside the Options tab. A greater SMA data buffer size may
result in a slower moving visualization.

Figure 20: Generic Data View Options

.~ Generic Data View Options

Mean Value Calculations Options

Algarithm: ® smA T EMA
EMA Weight 0.10
SMA Data Buffer Size 10

View Options

Display Refresh Rate (fps) 30

Choose between two different algorithms used for calculation of the averaged measurement results:

— Simple Moving Average: The mean calculated of the previous N data without any weighting. The SMA Data Buffer
Size defines the magnitude used for SMA calculations.

— Exponentially Weighted Moving Average: A type of an infinite impulse response filter that applies exponentially
decreasing weighting factors. The weighting for each older datum decreases exponentially but never reaches zero.
EMA Weight implies the quantifier used for the calculation of the EMA. Lower values result in less weighting of past
measurement outcome and thus longer averaging times.
= Sigma of Binned Range: The blue cloud determines the current time based on moving the standard deviation of the
sensor signal; inside the 1D Plot Options, choose between a deviation width of 1 Sigma and 3 Sigma.

Broadcom AFBR-S50-EK-UG103
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Figure 21: 1D Plot Options

Options
) 1D Plot Options
Top Chart
Raw Range
Smeoothed Range
Sigma of Range
) 1 Sigma ® 3 Sigma
Max. Range [m]:
Min. Range [m]:
Auto Scaling

Left Chart

Amplitude

Integration Energy

O Digital Integraticn Depth

Center Chart
[] Object Angle X
[] Object Angle ¥

Right Chart
Active Pixel Count
Saturated Pixel Count

[] Plot Valid Data Only
Plot Data Buffer Size

3.88
a8.88

lee

The different plots of the Range plot element can be turned either on or off by selecting the respective check boxes inside
the Options Panel. It is also possible to change the minimum and maximum displayed range of the respective axis or select

the Auto Scaling option.

Broadcom
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Figure 22: 1D Plot Options

Options v 1 X
) 1D Plot Options

Raw Range

Smeoothed Range

Sigma of Range
rmlSigma (@) 5 <igma

rMax. Range [m]: 3.00 | )

Min. Range [m]: 8.88

L Auto Scaling

Left Chart

Amplitude

Integration Energy

O Digital Integraticn Depth

Center Chart
[] Object Angle X
[] Object Angle ¥

Right Chart
Active Pixel Count
Saturated Pixel Count

[] Plot Valid Data Only
Plot Data Buffer Size 188

Figure 23: 1D Plot Example

100000 1000

___ Integration Energy
(Depth x Power)

= —— Amplitude r

10000 100

1000

Amplitude [LSB]

[#] Afisaug uonestiag)

= Integration Energy: Calculated by the integration depth per sample times the optical output power.

m  Amplitude (Maximum) Plot: Shows the current maximum measurement signal amplitude, which is determined by all
pixels that are selected by the Pixel Binning Algorithm.

Broadcom AFBR-S50-EK-UG103
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Figure 24: Active Pixel Count vs. Saturated Pixel Count

32

— Active Pixel Count
— Saturated Pixel Count

24

16

g B

0 20 40 &0 80

Pixel Count

100

m Active Pixel Count: The value of Active Pixel Count reveals the number of pixels that are used for calculating range and
amplitude with respect to the current Pixel Binning Algorithm.

m Saturated Pixel Count: The value of Saturated Pixel Count reveals the number of pixels being in saturation state due to
too much optical power received.

Broadcom AFBR-S50-EK-UG103
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2.3.2 3D Plot View

The second tab of the Data Visualization Window opens the 3D Plot View revealing more pixel-specific information on the

measured range and amplitude in real time:

Figure 25: 3D Plot View

[Reset Camera View,

fange [m]
10

P

Amplitude [L5B)

Amplitude [L58]
2048

Status/Log: 2015-05-17 5:20:44.410  Info: Device Controller: AFBR_SSWSSG pixel binning arrived.

This 3D Plot View shows the retrieved measurement signal of every single pixel of the sensor's pixel matrix.

m 3D Range: The left plot shows the time based average range values for each available pixel.

= 3D Amplitude: The right plot inside the 3D plot view shows the time based average amplitude values for each available

pixel.

There is also a Color axis for each of the two 3D plots that highlights the corresponding signal magnitude.

Hide binned pixels to see only pixels considered valid for the measurement by enabling the Hide Binned Pixels in Plots

option in the 3D Plot options tab.

Broadcom
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Figure 26: Hide Binned Pixels Option

~'~) 3D Plot Options
3D Range Plot

Color Axis: ® Range O Amplitude
Max. Range [m]: 16.888
Min. Range [m]: 9.868

[ Auto Scaling

3D Amplitude Plot

Max. Amplitude [LSB]: 2048.0
Min. Amplitude [LSB]: 8.8
Auto Scaling

Hide binned pixels in plots

Invalid pixels that do not satisfy the binning criteria will disappear from the plot.

Figure 27: Hidden Binned Pixels

Device | Connect: | COM7 | § ¥ | Measure: MiSingle W Start M Stop | OReset _
2Dt |30Plot X [RawData =

0 (0K) @ 521662096 sec (Frame Rate: 16.23 H2)
alog = 6.000 Pattern; Digital = 65 Samples
15 158

oth - An Switch
31 LsB; Pixel Gain

- -204as
T.sE 1536 i
0
‘Lx =3 Vi-x -
For a closer look at each pixel, zoom and rotate the 3D plots using the mouse.
= To move a plot, click and hold the scroll wheel.
m Rotate the plots by clicking and holding the right mouse button.
= Use the scroll wheel to zoom in and out.
= Double-click the scroll wheel to reset a plot to its default point of view.
Broadcom AFBR-S50-EK-UG103
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2.3.3 Raw Data View

The raw data view is not visible by default, it has to be enabled in the help menu first.

Figure 28: Enabling the Raw Data View

Device | View | Help

Serial Trace Tool Bar

[<]

Device Tool Bar

Data Logger Tool Bar

Options Panel
API View

Summary View
1D Plot View

Raw Data View

Raw Data view gives additional details about each pixel's measured range and amplitude results including the corresponding
mean values and signal deviations (referred to as sigma). Furthermore, Mean and Sigma of both Raw Range and Raw
Amplitude can be displayed as either SMA or EMA weighted (Mean(s), Mean(e), Sigma(s), Sigma(e)). The above
screenshot shows not all Pixels for reason of better overview. Keep in mind that the choice of SMA and EMA affect the
displayed values of Sigma and Mean in different ways.

Figure 29: Raw Data View

») Pixel View Options

Mumeric Format a.8a8a
Sample Values
Raw [_] Mean [] Sigma [[] Min/Max

Range Values
Raw Mean Sigma [ Min/Max

Amplitude Values
Raw Mean Sigma [ Min/Max

Phase Values
Raw Mean Sigma [] Min/Max

[ Pixel Status Values
O Signal-To-Moise Ratio (SNR)

By enabling the Pixel Status Values check box, the Raw data view displays several status flags for each pixel.

Broadcom AFBR-S50-EK-UG103
21



AFBR-S50 User Guide

Evaluation Kit Quick Start Guide

Figure 30: Single Pixel Status

Pixel (5,2)
Status: ebeeoeooee
- Saturated: False
- 1D Binned: True
- Ampl. Min: False
- Pre-Filt.: False
- No Signal: False
- Outofsync: False
- Stalled: False
Range:
Raw: 1.08140
Mean(s): 1.0146
Sigma(s): ©.4428
Amplitudes:
Raw: 497.9375
Mean(s): 498.4213
Sigma(s): ©.4428

For a detailed description of the single statuses, open the API reference manual and type argus _px_status_t in the

search field.

Choose which of the results to keep visible or hidden by selecting the associated Pixel View Options from the Options Panel.

In addition, the Numeric Format of the displayed results can be adapted.

Figure 31: Pixel View Options

~(») Pixel View Options

Numeric Format
Sample Values
Raw [_] Mean [] Sigma [] Min/Max

Range Values
Raw [v] Mean Sigma [ ] Min/Max

Amplitude Values
Raw [v] Mean Sigma [ ] Min/Max

Phase Values
Raw [v] Mean Sigma [] Min/Max

Pixel Status Values
[] Signal-To-Noise Ratio (SNR)

2.0000
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2.4 Tool Panel Overview

This section introduces the tool panel which is located on the right side of the explorer GUI.

Figure 32: Location of the Tool Panel in the GUI

2.41 API Tab

In general, this tab is organized in the three categories: Generic API, Configuration API, and Calibration API. All functions
and accessible parameters shown in this section give an overview about the interoperability with an AFBR-S50 sensor. As
indicated in Figure 33, applicable settings have a Get, Set, or both button on the right side to either retrieve the current

parameter setting from the sensor (Get) or send a new target setting to the sensor (Set).

Figure 33: Configuration APl with Get/Set Buttons

API
[ Generic API

- Canfiguration API
Measurement Mode:
Frame Rate [Hzl:
Dual Frequency Mode:
Shot N Monitor Mode:
~ P ing Algorithm (PBA)

A
g Made

Absolute Amplitude Threshold [LSE
hreshold
Scope Enable

Averagi

Relative Amplity
Minimum Dista

Absolute Minimum Distance Scope [m]
Relative Minimum Distance Scope

ShortRange

LAWA

~J Get | Set

Got [set

vl Get [ Set

Get | Sat

1
Get| Set

[~ Calibration API

Generic API

When the connection to the evaluation board is established, the Generic API section is filled with important information on

the device, such as the API and explorer version number, module type, chipID, and so on.
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Configuration API

This is the category where users can modify basic settings of the sensor, such as the measurement mode, frame rate, dual
frequency mode, shot noise monitor mode as well as optimizing the pixel binning algorithm settings. However, because all
predefined settings are based on empirical data for best sensor operation, there is no need to change unless there is a

known reason.
Figure 34: Configuration API

APl (#1)

C ~) Generic API

~(#) Configuration API

Measurement Mode ShortRange ¥ | Get||Set
Data Output Mode StreamingFull ¥ | Get||Set
Frame Rate [Hz] 25 || Get||Set
Dual Frequency Mode X8 ¥ | Get||Set
Shot Noise Monitor Mode Dynamic ¥ | Get||Set
Crosstalk Monitor Get||Set
~(») Pixel Binning Algorithm (PBA)
Enable PBA
Averaging Mode LAWA v
Absolute Amplitude Threshold [LSB] 28
Relative Amplitude Threshold 8.5
Absolute Minimum Distance Threshold [m] -9.010
Minimum Distance Scope Enable
Absolute Minimum Distance Scope [m] 9.058@
Relative Minimum Distance Scope 0.e4
Get||Set

C ~) Calibration API

Calibration API

In general, each AFBR-S50 ToF sensor is factory calibrated and immediately ready to take measurements. When it comes
to a system integration, it may be necessary to optimize the performance for a specific application, which can be carried out
by the calibrations offered in this section of the API tab. It consists of two main subsections, which are the Range Offset

Calibration and the Crosstalk Calibration.

Figure 35: Subsections of Calibration API

~! Cali ion API
Range Offset [mm] ]

~ Range Offset Calibration )

~ Calibrati
C Crosstalk )
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2.4.1.1 Range Offset

This parameter gives you the opportunity to compensate application-specific distance offsets. If the ToF sensor is part of a
system that has another reference edge for assessing the distance, the offset between sensor and this reference edge must
be defined with the Range Offset parameter.

Formula: Range = RawRange — RangeOffset

Figure 36: Range Offset

{ ~) Calibration API ~) Calibration API
R [R

ange Offset [mm]: 20 @ E ange Offset [mm]: -20 @ @

NOTE: Be careful when setting this parameter because range values may turn negative.
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2.4.1.2 Range Offset Calibration

Unlike the Range Offset parameter, which affects the binned range value, the following pixel offset from table shown in
Figure 37 intends to do the same for each single pixel range by performing a calibration on a reference plane. The distance
in meters to the reference plane can be entered in Calibration Target Distance [m] field. After clicking the Run Range
Offset Calibration Sequence button, the table is filled with the values and distance offsets that are written to the sensor.
The generated calibration data can also be imported and exported for further processing or analysis. Single offset values
can also be modified and requested by using the Get and Set buttons.

The main purpose of this calibration procedure is to enable and improve gesture detection applications by minimizing the
range offset among the single pixels of the 32-pixel array on the receiving side. The effect of this calibration is depicted in
Figure 38.

Figure 37: Range Offset Calibration Table

~ Range Offset Calibration

Pixel {0,0) Offset [mm] 5.0
Pixel {0,1) Offset [mm] 9.0
Pixel (0.2) Offset [mm] 0.0
Pixel (0.3) Offset [mm] 8.0
Pixel (1,0 Offset [mm] 6.0
Pisel {1,1) Offset [mm] 0.0
Fixel (1,2) Offset [mm)] 0.8
Pixel (1,3) Offset [mm] 8.8
Pixel (2,0) Offset [mm] 0.8
Pixel 2.1) Offset [mm] 0.0
Pixel (2,2) Offset [mm] 0.0
Pixel (2,3) Offset [mm] 8.0
Pixel (3,0) Offset [mm] 0.0
Pixel (3,1) Offset [mm] 0.0
Pixel (3.2) Offset mm] 0.0
Pixel (3.3] Offset [mm] 0.0
Pixel {4,0) Of [mm] 8.9
Pixel (4.1) Offset [mm] 8.0
Pixel (4,2) Offset [mm] 8.0
Pixel (4,3) Offset [mm] 8.0
Pixel (5.0) Offset [mm)] 0.0
Pixel (5,1 Offset [mm] 0.0
Pixel (5,2) Offset [mm] 0.0
Pixel {5,3) Offset [mm] 6.0
Pixel (6,0) Cffset [mm] 9.9
Pixel (6,1) Offset [mm] 6.0
Pixel (6,2) Offeet [mm] 0.0
Pixel (6,3) Offset [mm] 0.0
Pixel (7,0) Offset [mm] 0.0
Pixel {7,1) Offset [mm] 6.0
Pixel (7.2) Offset [mm] 9.9
Fixel (7.3) Offset [mm] 0.0
Calibration Target Distance [m]:
| Export Vector Table to File..
[ import Vectar Table from Fie..

Figure 38: Effect of a Pixel-to-Pixel Range Offset Calibration

Range of about 17 cm Range of about 17 cm
Zoomed in, uncalibrated Zoomed in, calibrated

Range of about 17 cm
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2.4.1.3 Crosstalk Calibration

Crosstalk (Xtalk) calibration is suggested to be carried out for each system design with implemented AFBR-S50 sensors. It
targets to compensate electrical crosstalk possibly generated by the application PCB, as well as optical crosstalk generated
by a cover glass mounted above the sensor and therefore affecting its optical path.

The following example shows the calibration of electrical crosstalk. For a full calibration of electrical and optical crosstalk (for
example, due to usage of a cover glass), refer to the crosstalk calibration application note.

Example Calibration Sequence for Electrical Xtalk Compensation Only

1. Blind the sensor with a foam while taking measurements, and make sure that the amplitudes are roughly as low as shown
in the following figure.

Figure 39: Blinding Sensor for Xtalk Calibration

1024 _

Example: 3D Plot of the Amplitude during
sensor operation

2. Click Run Crosstalk Calibration Sequence located in the API tab.

1024

Shade the sensor with a black foam

Figure 40: Crosstalk Calibration Amplitude

Pixel (7,1)
Pixel (7,2)
Pixel (7,3)

0.00 0.00
0.00 0.00
0.00 0.00

Run Crosstalk Calibration Sequence

Reset to Factory Calibrated Default Values

Export Vector Table to File...

Import Vector Table from File...

»

Pixel (7,1)
Pixel (7.2)
Pixel (7,3)

-1.38
-0.81
-0.75

-0.69
-1.44

-1.38
Get||Set|

Run Crosstalk Calibration Sequence

Reset to Factory Calibrated Default

Values

Export Vector Table to File...

Import Vector Table from File...

API| Summary | Options

Press button for xtalk calibration

API | Summary | Options

xtalk table is filled with values

While being shaded, the amplitude of the sensor is
dropping down to about 2 LSB

3D Plot after xtalk calibration

The Xtalk vector table is immediately applied to all pixels. For further information, refer to the information in the cover glass
calibration guide.
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2.4.2 Summary Tab

The Summary tab shows current measurement results as well as generic and DCA information. As the last part of the
measurement results section, the auxiliary parameters give the user additional information on the internal voltage and
current levels in units of the ADC, the ASIC temperature and environmental information, such as a Background light indicator

(in arbitrary units), and the connected shot noise amplitude.

Figure 41: Summary Tab

Summary e Xx
~ Generic
Status: OK [0)
Timestamp: 644.180784 s
Frame Rate (actual value): 2500 Hz

Measurement Mode:

Mode B: Short Range

Frame Frequency: A-Frame
Pll Locked: 100% [v]
Background Light Warning: O
Background Light Error: O
~ DCA
Digital Integration Depth 94 Sampl.
Analog Integration Depth 8 Pattern
Optical Power Stage High
Optical Power Value 71 mA
Pixel Gain Stage MediumLow
Pixel Gain Value 38 LS8
~ 1D Measurement Results
Raw Range 2875 m
Smoothed Range 2871 m
Sigma Range 1173 mm
Amplitude 743 LSB
Smoothed Amplitude 744 LSB
Sigma Amplitude 0.73 LSB
Pixel Count 1 Pixel
r ~' 3D Measurement Results
Amplitude (Pixel Average) 62 LSB
Amplitude (Pixel Maximum) 743 LSB
Saturated Pixel Count Pixel
r~ Auxiliary M,
Supply Voltage (VDD) 2785.1 LsB
Laser Supply Voltage (VDDL) 2759.7 LsB
Substrate Voltage (VSUB) 33333 LS8
APD Current (IAPD) 1996.7 LSB
Temperature (T) 354 °C
Background Light (BGL) 24
Shot Noise Amplitude (SNA) 23 LSB
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All of the available tab settings were already explained except for the API Advanced Options. These options give advanced
users the possibility to further modify the PBA or DCA settings, which can be unlocked by selecting the Advanced Mode
check box as shown in the figure below.

Figure 42: Advanced Mode — APl Options

»~) APl Options a
[ | Advanced Mode

When selected, the user can access more parameters that have appeared in the API tab, which enable a refinement of PBA
and DCA settings. Tooltips provide more information about each parameter.

Figure 43: API Advanced Options Example Shown for the Configuration API Section

( v) Generic API ) C v) Genhetic API )
r») Configuration API ~(~) Configuration API
Measurement Mode ShortRange ¥ | Get||Set Measurement Mode ShortRange v | Get||Set
Data Output Mode StreamingFull v |Get||Set Data Output Mode StreamingFull v [Get||Set
Frame Rate [Hz] 25| Get||Set Frame Rate [Hz] 25| Get|[Set
Dual Frequency Mode X8 ~ [ Get||Set Dual Frequency Mode X8 v | Get||Set
Shot Noise Monitor Mode Dynamic ¥ | Get||Set Shot Noise Monitor Mode Dynamic v [Get||Set
Crosstalk Monitor Get||Set Crosstalk Monitor Get||Set
[_ v) Pixel Binning Algorithm (PBA) ] Smart Power Save Mode D Get||Set
( ¥ Calibration API ] (- v) Pixel Binning Algorithm (PBA) )
~(») Dynamic Configuration Adaption (DCA)
Enable DCA [m]
Saturated Px. Threshold for Lin. Decrease [#] 1
Saturated Px. Threshold for Exp. Decrease [#] 3
Saturated Px. Threshold for Sudden Reset [#] 5
Target Amplitude [LSB] 2000
Low Amplitude Threshold [LSB] 1000
High Amplitude Threshold [LSB] 3000
Amplitude Mode Maximum v
Nom. Integration Depth [#Pattern] 4
Min. Integration Depth [#Pattern] 9.03
Max. Integration Depth [#Pattern] 8
Laser Modulation Current/Power Stages Auto =

Nom. Gain Stage

MediumLow ¥

Min. Gain Stage Low V
Max. Gain Stage High >
Power Saving Ratio [%)] 2}
Get||Set

) SPI Setup
Baud Rate [bps] 8| Get||Set

C ~) Calibration API
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2.5 Multi-Device Usage

From v1.4.4 on multi-device controls and views via one MCU are implemented in the AFBR-S50 explorer application. Click
Main, Add new AFBR-S50 Device. The new views for a second device display on the screen.

Figure 44: Add New Device

Main | Device #1 View Help

| Add new AFBR-S50 Device

Each device can be controlled individually with its own controller toolbar. Addresses are assigned automatically.

Figure 45: 1D View of Four Sensors Running in Parallel in One AFBR-S50 Explorer Instance
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Appendix A: Troubleshooting and FAQs

A.1 Related Documents

n  AFBR-S50xxxxx Data Sheet
n  AFBR-S50 Software Release Notes

A.2 Different Versions of Explorer and Controller Board

If an error message indicates that the software versions of the AFBR-S50 Explorer and microcontroller device software do
not match, you may have an older or incompatible FW running on the evaluation board.

Figure 46: Error Message

Device Software Version (@.9.5) do not fit to the Explorer Wersion (1.x.x)!
The systems communication interface is probably incompatible.
Please update your software.

SCI: Deserialization error on received frame! Command: Configuration (configuration);
5CI: Rx Frame too short.

SCI: Deserialization error on received frame! Command: Calibration (calibration);
5CI: Rx Frame too short.

When upgrading to v1.x, the USB driver version is updated automatically. When downgrading manually to versions older
than v1.x, you might need to install the older USB driver as well.

Flash the appropriate device software version onto the NXP microcontroller board by following the procedures in Updating
the Device Software.

Figure 47: Flashing the Device Software

Device View | Help

| Deviee ¥ 7 Flash Device Settings ... bset

Flash Device Software Flash "\Device\BinanA\AFBR.S50.ExplorerApp.vxxxKL46z_USB.srec” ...

1D Plot X |3DF

Reset Application Layout

Measurement S @09 sec (Frame Rate: NaN Hz) @
DCA: Integrat Reset Application Options tal = @ Samples
Optical
Reset All
— Ray Open Log File
— Smy
Sig Open App Data Folder
Open Getting Started Guide
Mnn Dalanen Motne
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A.3 SCI Error - No Communication to Sensor
Figure 48: SCI Error

SCI: Failed to open an USB connection

If the issue persists, try the following steps:

- reset your device (push the reset button on the board or reconnect the USB cable)

- verify that the device is connected correctly to the "KL46Z" USB port (not the "OpenSDA"™ USB port)

- verify that the device is running the current device software version (i.e. re-flash the software via "Menu->Help->»Flash Device Software...")

In principle, this message can have multiple reasons. Most likely, the USB cable was plugged into the openSDA (see
Figure 7) instead of the KL46Z USB port. Another reason can be that the device software is corrupted and must be flashed
again (see Section A.2, Different Versions of Explorer and Controller Board). Because this error indicates a serial
communication issue, it is also possible that your sensor is defective or the USB cable might need to be replaced.

A.4 Xtalk Calibration — 3D Plot Is Not Visible

Figure 49: Xtalk Calibration

51 ~(») 3D Plot Options
2 512 3D Range Plot
Color Axis:
512 e - Max. Range [m]:
Min. Range [m]

(O}

25 [ Auto Scaling
84 - L. 384 B [ Relief Mode

384 b 384 [ Inverted Relief Mode
L 3D Amplitude Plot

Max. Amplitude [LSB]:
Min. Amplitude [LSB]:

2 - -
56 - |- 256 256 L Auto Scaling
Plot smoothed data
Hide binned pixels in plots
128 -| [-128 ~) API Options
128 - - 128 [[l Advanced Mode

(%) Generic Data View Options

Mean Value Calculations Options

Algorithm:

o EMA Weight

o "
SMA Data Buffer Size

If there is an empty amplitude chart, it might be that the check box for Hide binned pixels in plots is still enabled. To see
low amplitudes while performing the Xtalk calibration make sure this option is not selected.

A.5 Xtalk Calibration — Amplitude Error

Figure 50: Amplitude Error Message

Message Log n

Device @ 18.612528 s

Xtalk calibration: maximum amplitude exceedance!

One or more crosstalk vector components are exceeding the maximum amplitude limit.

In order to perform a crosstalk calibration, the receiver lens must not receive any signal from the sender lens, e.g. by covering the sensor or targeting to infinity.
Please verify your setup and calibration results and repeat...

Device @ 18.613680 s

crosstalk Vector calibration sequence failed to execute, error code: -112 (Crosstalk Vector Amplitude Too High)

SCI: Sending Tx Frame (cmd: MeasurementCalibration (ex18)) failed: device responded with NAK

Error code: -112 (Crosstalk Vector Amplitude Too High)

Device @ 18.658784 s

received command @x18, decoding/execution failed!

command error code: -112 (Crosstalk Vector Amplitude Too High)

Device @ 18.659104 s

Scheduler: task (name: "Handle SCI Command” - prio 6) execution failed, error code: -112 (Crosstalk Vector Amplitude Too High)
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This error appears when the amplitude exceeds the default maximum amplitude of 20 LSB while running the Xtalk
calibration. For Step 2 and Step 3 of the Xtalk calibration (necessary to compensate cover glasses), it might be necessary
to increase this limit. This can be done in the Calibration Sequence Setup section at the bottom of API tab.

Figure 51: Calibration Sequence Setup Section

+) Calibration Sequence Setup

Crosstalk Sample Count: 128
Max. Crosstalk Amplitude: 20.0

APl | Summary | Options

If it is not visible, you might need to enable the Advanced Mode in the Options tab.
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m Updated for new release.
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m  Updated for new release.

AFBR-S50-EK-UG101; May 6, 2020

m Updated for new release.

AFBR-S50-EK-UG100; December 6, 2019

= [nitial release.
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